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This manual contains information for HD Connect the Desktop App for the Forney HD Flame Detector 

from Forney Corporation, 16479 North Dallas Parkway, Suite 600 Addison, TX 75001.

All personnel should become thoroughly familiar with the contents of this manual prior to using this 

product. Because it is virtually impossible to cover every situation that might occur during operation 

and maintenance of the equipment described in this publication, personnel are expected to use good 

engineering judgment when confronted with situations that are not specifically mentioned herein.

PROPRIETARY NOTICE

The contents of this publication are proprietary data of Forney Corporation. Reproduction or use of any 

part of the publication for purposes other than the support of the equipment for which it is published is 

permissible only if expressly authorized in writing by Forney.

SAFETY AWARENESS

Safety is YOUR responsibility and must always be primary concern. The guidelines covered in this 

manual will greatly improve your ability to safely install and maintain this equipment. It is the equipment 

owner’s responsibility to ensure that the concerned personnel fully understand and abide by all site-

specific Health, Safety, and Quality protocols. Safety summaries and procedures can never replace good 

common sense!

PERSONAL PROTECTIVE EQUIPMENT (PPE)

All involved personnel should follow their site-specific Health, Safety, and Quality guidelines.

SAFETY ALERT SYMBOLS

ALL labels in this manual should be carefully observed, read, and understood. Standard labels are as 

follows:
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INTRODUCTION

DANGER Indicates a hazardous situation which, if not avoided, will result in 
death or serious injury.

WARNING Indicates a hazardous situation which, if not avoided, could result in 
death or serious injury.

CAUTION Indicates a hazardous situation which, if not avoided, could result in 
minor or moderate injury.

NOTICE Indicates unsafe practices that can result in property damage only.



REVISIONS

REVISIONS DATE COMMENTS

A 07/17/2018 Initial Release

B 02/15/2019 Update Monitor and Tune Screen shots, add note on page 4

C 03/20/2020 Added Bluetooth® Section
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NOTICE: If any of the procedures or instructions provided in this manual are unclear, contact 
Forney for clarification. Forney Corporation offers complete, on-site service solutions to ensure 
proper installation, programming, commissioning, and troubleshooting.

12/22/2020 General Rewrite
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HD Connect software is a user-friendly tool used to monitor performance and tune the HD Flame Detector 
using a Windows® computer. The software connects to the HD Flame Detector via RS-485 connection 
(Communication port).

HD Connect can be installed on a Windows® computer running Windows 8 or later. Please follow 
installation instructions provided separately to install the software.

Note:
1. HD Connect and HD App cannot be simultaneously connected to the same HD-01 Flame Detector. 
    At any given time, an HD Detector can communicate with only one external device (either through HD 
    Connect or the HD App).
2. When using HD Connect, if an HD Flame Detector does not appear in the list of connected devices, 
    check and verify if the target device is already connected to a mobile device using Forney App over the 
    Bluetooth® connection. If the target HD Detector is connected via Bluetooth, first disconnect Bluetooth 
    connection, then hit refresh button in HD Connect to discover the target device.
3. A maximum of 32 HD-01 Flame Detectors can be connected on a single USB/COM port using the RS-
    485 connector. If more than 32 HD-01 Flame Detectors need to be connected to the same computer, 
    the user must either use a USB hub or connect them on multiple USB ports on the computer.
4. If HD Connect or any DCS controller is continuously pulling data from an HD Detector, it must be 
   disconnected (by unchecking the corresponding box in HD Connect Software -- see Section 1.3) on  
   COM port of HD Connect or other prescribed procedure for DCS controller prior to connecting it via 
    Bluetooth. Furthermore, the Forney App should be launched on the mobile device after disconnecting 
    the HD from COM port.

SECTION 1
HD CONNECT OVERVIEW
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HD Connect launches with a Login screen as shown in the Figure 1. HD Connect has two possible user 
types: admin and standard. The admin users can add, delete and modify permissions for new or existing 
users, while standard users have restricted access.

Admin users have permission to all functions of HD Connect.  Figure 2 and Table 1 below list the functions 
controlled by Admin users for standard users.  The Admin can enable or disable features for the Standard 
User to grant them permissions selectively. 

Several features in HD Connect allow users to save data in log files, change register values, view live 
data or change HD parameters. The permission to perform these functions are set by admin users for 
standard users.

Figure 1 Login Screen

LOGIN SCREEN1.1

USER SECURITY CONFIGURATIONS1.2
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*Forney recommends enabling these features for all standard users.

Figure 2 Security Configuration Pop-up Figure 3 Standard User Security Options

Table 1 Permissions for Standard Users

Spectrum* Allows users to view the Spectrum screen. Section 2.2.1

Saved Tuning Allows users to view previously Saved Tunings. Section 2.2.3

Log View* Allows users to save and view log files. Section 2.2.2

Localization Allows users to change the language for the HD Connect. 
Options are: English, Spanish, and Chinese. Section 2.3

Fault Log Allows users to create and view Fault Logs. Section 3.2

Monitor* Allows users to view the status of HD Detectors. Section 4.1

Tune Allows users to make changes to the tuning of the HD Flame 
Detector. Section 4.4

Tags
Allows users to troubleshoot HD Detectors. Good understanding 
of Tags is required, so Admin should be careful in allowing user’s 
permission for this feature.

Section 4.6

Live Trend* Allows users to view Live Trends, which are useful to learn HD 
current and future trends. Section 4.7

Data logging* Allows users to log data from Monitor page. Section 4.9

Fault Status* Allows users to view and reset Faults. Section 3.2
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Once a user logs onto HD Connect it launches a welcome screen as shown in the Figure 4. The left side of 
the screen (referred as equipment tree) has the list of COM ports and devices attached to each COM port. 
The check-box in the equipment tree can be used to connect/disconnect any COM port or equipment.

The top of the screen has 4 menu items and 5 icons. The menu items are described in Section 2 while the 
icons are described in Section 3.

The large window on the right side of the equipment tree displays the icons of currently connected HD 
Flame Detectors.

• A green box around the icon represents a fully operational HD Flame Detector with no issues.
• An orange box around the icon represents a fault on the HD Flame Detector.
• A red box around the icon means there is no communication between the HD Detector and the computer.

A pop-up menu opens upon right-mouse click on any icon. Details of the pop-up menu are described in 
Section 4.

WELCOME SCREEN1.3

Figure 4 Welcome Screen
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The four (4) menu items in the top area of HD Connect are:

• File     • View • Settings • Help

The File Menu has 6 sub-menu items:

FILE MENU2.1
Figure 5 File Menu

Table 2 Description of Menu Options

SECTION 2
MENU OPTIONS

Save View

Saves the current view in a file at desired location on the computer. The HD Flame 
Detector icons can be rearranged in any desired manner as explained in Section 
2.2.4. The Save view option allows users to arrange icons in different ways and save 
their view.

Open View Allows user to upload previously saved view. Essentially, it rearranges the icons on 
screen in user’s preferred way that was previously saved by the same user.

Refresh

If HD units are added/removed in the daisy chain, their status can be updated by 
pressing Refresh. This menu option updates the list of current HD Detectors  
connected by RS-485; it also updates the status of all the detectors currently  
connected via USB port.

Logout Logs out the current user from the software and returns to the Login Screen

Security 
Configuration

Opens a pop-up window, see Section 1.2.
Admin users can create/delete admin or standard users or change permissions  
for standard users.
Standard users can view their permissions in this pop-up window.

Exit Logs out the current user and exits HD Connect application.
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VIEW MENU2.2
The View Menu has 4 sub-menu items.

The pop-up window for “Spectrum” sub-menu has two drop-downs:

1. Port Address: displays the list of COM ports with active devices.
2. Device Address: shows list of connected HD Flame Detectors for the selected COM port.

After selecting desired COM port and Flame Detector, click “Display” to see the IR/UV spectrum.  
The Spectrum window is explained in detail in Section 4.5.

Figure 6 View Menu

Figure 7 Pop-up Window for Spectrum

Spectrum2.2.1
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The pop-up window for “Log View” has two drop-downs on the left side:

• Select Port: lists COM ports with active devices.
• Select Slave: lists connected HD Flame Detectors for the selected COM port.

The middle section allows the user to filter specific “From” and “To” dates and time. Clicking the “Show” 
button on the right side displays the filtered results. If date and time are left blank, then the results window 
will show all results.

As shown in Figure 9, the results page displays the list of registers changed, their old and new values, 
change date, and user who changed the value.

Admin users can add privileges for standard users and decide if a user can view the historical changes in 
the register values as explained in Table 1. Whenever any parameter for a HD Flame Detector is changed 
(using Tune window), the value in corresponding register changes. The changes in the registers are 
logged and can be viewed later. This information can be useful for Forney Professionals to troubleshoot 
issues with HD Flame detector.

Figure 8 Pop-up Window for Log View Sub-menu

Figure 9 Results of Log View Filter

Log View2.2.2
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The “Saved Tuning” option allows users to upload the same settings on multiple HD Flame Detectors. 
The user can load a previously saved tuning, Section 4.4.3 explains how to save a tuning. The software 
will redirect and populate the Tune Page to show these retrieved parameters from the encrypted file on 
the computer. These settings can then be uploaded to the connected HD Flame Detector by clicking 
“Update Detector” button.

The “View” option under the “View” menu has three options.  Please note that the Bluetooth® Symbol 
shows Bluetooth® status for the HD Flame Detector wherein gray symbol means Bluetooth® is OFF 
while blue symbol represents Bluetooth® ON status.

Standard View lists all the connected flame 
detectors sorted by COM port.

This view cannot be customized.

Run-Time View shows the current Flame 
Status and corresponding Flame Strength 
for each detector. The user can arrange 
these icons as desired and then save 
their view for future use, as explained in  
section 2.1
. 
Note: Value displayed for FR1 (or FR2) is 
higher of maximum intensity in FW1/FW2 
for respective FR.

Saved Tuning2.2.3

Views2.2.4

NOTICE: Previously saved tunings do not include Device Settings. These settings should be 
manually changed, if needed, prior to clicking “Update Detector”. If an application requires use 
of more than one profile, each profile must be activated through profile select inputs prior to 
updating detector.
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Settings menu, shown in Figure 10, offers the user three (3) languages:

• English,
• Chinese, and
• Spanish.

Once the desired language is selected, the application logs out to convert the software to the selected 
language. The user then needs to log back in to view HD Connect in the desired language.

SETTINGS MENU2.3

Figure 10 Settings Menu – Language Selection
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HELP MENU2.4
The Help menu has two (2) resources available for users:

1) About
2) Instruction Manual and
3) Terms and Conditions.

About shows the version information for HD Connect while clicking either of the other two options opens 
the respective document in pdf format.

Figure 11 Help Menu Options
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LOGOUT ICON3.1

Figure 12 shows the HD Connect icon bar which consists of 5 icons:

• Logout,
• Fault Log,
• Log View,
• Spectrum, and
• Exit.

Logs out the current user and redirects to the login page. Admin users can create new user and set their 
permissions as needed.

Figure 12 HD Connect Icon Bar

SECTION 3
ICONS BAR
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FAULT LOG ICON3.2

LOG VIEW ICON3.3

SPECTRUM VIEW ICON3.4

REFRESH ICON3.5

A pop-up window opens when the Fault Log icon is pressed. The pop-up window (left picture in Figure 13) 
allows user to select ‘From’ and ‘To’ date and time to display the faults occurred within the time-frame. 
The fault list results (right picture in Figure 13) shows all the faults occurred in all the HD Flame Detectors 
connected within the time-frame selected on the prior window.

Opens the Log View Pop-up Window. See Section 2.2.2 Log View.

Opens the Spectrum screen. See Section 4.5 Spectrum

When pressed, the Refresh icon refreshes the list and status of HD Flame Detectors in the Equipment 
Tree and Icons area (Please see Section 1.3 for the description of the two windows).

Figure 13 Fault List in HD Connect



HD Connect Manual
372001-22 Rev D

13

The large area on the right side of the HD Connect screen displays an icon for each HD Flame Detector 
currently (or previously) connected via RS-485. The icons can be displayed in three different views as 
described in Section 2.2.4.

Right mouse click on any of the HD icons to make a pop-up menu open as shown below. These menu 
options are explained in detail in the following sub-sections. Please note that one (1) window can be 
opened for each HD Detector. HD Connect does not allow multiple windows for a single HD Detector.

Figure 14 Right-Click Menu Option for HD Icons

SECTION 4
HD ICON MENU
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MONITOR WINDOW4.1
The Monitor Window displays the status of the desired HD Detector. The user can view the status of 
the Flame Relay 1 or 2 for the active profile from 0 to 3. The Monitor screen shows the current values of 
several parameters and various set-points for the selected flame relay and profile combination.

Figure 15 Monitor Window in HD Connect
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MONITOR OR TUNE WINDOW4.2
Monitor and Tune screens have several common fields. These fields are explained in this section with the 
help of data processing flow.

Table 3 Common Fields Defined

Sensor Displays sensor type for respective Flame Relay (FR1/FR2) UV or IR

Sensor Signal

Displays sensor signal strength on a scale of 0-1023 after processing 
though pre- amplifier. Displayed value is influenced by amount of optical 
radiation received by the sensor and the preamp gain set by the user. 
It is recommended that in no case this signal value should reach 1000. 
The sensor signal strength in range 200-600 will help improve flame 
discrimination.

Preamp Gain User adjustable preamp gain (1-255) to achieve sensor signal as 
described above.

Gain

User adjustable Gain (1-255). Sensor Signal at the output of pre-
amplifier stage is processed through second amplifier. Output of 
amplifier is processed by microprocessor and results of FFT are 
presented in Spectrum screen. X scale of the spectrum displays 256 
bins at interval of 2 Hz, while signal amplitude at each bin is displayed 
on Y axis. Its recommended that in no case signal strength on any 
bin should reach 1000. Optimize Gain / Preamp Gain settings to keep 
signal amplitude at burner characteristic frequency bin around 600. 
 
 
 
 
 
 
 
 
 
 
IR Spectrum with Frequency Windows 1 and 2 shown in blue 
and orange colors respectively, and DO/PU shown in green color 

Frequency Window 1, 
Amplitude 1

Highest amplitude between two frequency bins (starting & ending) is 
displayed as Amplitude 1

Frequency Window 2, 
Amplitude 2

Highest amplitude between two frequency bins (starting & ending) is 
displayed as Amplitude 2
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Weight

User adjustable between 1-5. Highest amplitude on each frequency 
window is multiplied by the weight setting and displayed as Amplitude 1 
and 2. Default value is 1. Increasing preamp gain or gain increases signal 
and noise together. It may lead to low signal to noise ratio. However 
higher weight setting only acts as a multiplier of Amplitude.

Amplitude PU/DO

Flame Relay status is controlled by comparing highest of two Amplitude 
(1&2) values against PU / DO set point. Flame Relay energizes if either 
amplitude is greater than PU setting and de-energizes if both amplitude 
values are below DO setting

Analog Signal % Displays analog output signal value in %. Analog signal is scaled as per 
the Min & Max settings on tune page.

Gain Trim Control
When on, automatically adjusts Preamp gain to maintain sensor signal 
to fixed value of 600. In dark furnace condition, adjusts Preamp gain to 
25 to avoid saturation.

Flame Failure 
Response Time 
(FFRT)

Flame Relay energizes if either amplitude is greater than PU setting and 
de-energizes if both amplitude values are below DO setting after expiry 
of FFRT setting. Default setting is 1 second; possible values are 2, 3, 
and 3.8 seconds.

TUNE WINDOW4.3
The Tune Window option allows the user to Tune the selected HD Flame Detector.

When the Tune option is clicked, a pop-up window opens requiring the user to enter a password as shown 
below. The Default Factory Password is 1234. Password can be changed under the Device Settings 
section.

Figure 16 Tune Password Window in HD Connect
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The “Extend Timer” button at the top right corner of the window can be used to extend the duration of 
tune mode in HD Connect without the need to provide HD Flame Detector’s Password (4-digit password).

Select Flame Relay Settings for FR1 or FR2 by clicking on the desired tab in the Tune Window Figure 17. 
The current settings are shown in green on the left, to change the set points for Frequency, Amplitude, 
Weight Factor, Pre-Amp Gain, Gain, Analog scale (%) and Gain Trim Control enter new values into the 
gray boxes on the right. See Table 3 for definitions of variables.

Click “Update Detector” or “Save Locally” to save your changes. See Save Tuning section for more 
details.

Figure 17 Tune Window in HD Connect

Flame Relay Settings4.3.1
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Device Settings4.3.2

Bluetooth® Disable4.3.2.1

Figure 18 Tune Window Device Settings Tab

Figure 19 Bluetooth® Disable Window

Click on the Device Settings tab to change Modbus Slave ID, Tag Name, FFRT value for each Flame 
Relay and Tune Password. Simply type in new values on the right and click to “Update Detector” or “Save 
Locally”. See next section for explanation of Save options.

The Bluetooth® toggle switch can be used to Enable or Disable Bluetooth® for the connected 
HD Detector.  If the Bluetooth® is currently enabled, click on the toggle switch to disable it.  
A pop-up window (Figure 19) would appear to request confirmation.  Please make sure to 
disconnect mobile device (if connected via Bluetooth) prior to clicking “Apply” on this window. 
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Figure 20 Bluetooth® Disable Confirmation Window 

After “Apply” is clicked on the window in Figure 19, a new Pop-up window (Figure 20) would 
appear to confirm that the Bluetooth® has been disabled.  However, the HD Detector must 
be power cycled for the change to go into effect.  The Bluetooth® chip will continue to remain 
enabled & Bluetooth® LED will continue to blink until the device is power cycled.

Bluetooth® Enable4.3.2.2

Figure 21 Bluetooth® Enable Window

Figure 22 Bluetooth® Enable Confirmation Window 

The Bluetooth® toggle switch can be used to Enable or Disable Bluetooth® for the connected 
HD Detector.  If the Bluetooth® is currently disabled, click on the toggle switch to enable it.   
A pop-up window (Figure 21) would appear to request confirmation.

After “Apply” is clicked on the window in Figure 21 a new Pop-up window (Figure 22) would 
appear to confirm that the Bluetooth® has been enabled.  However, the HD Detector must 
be power cycled for the change to go into effect.  The Bluetooth® chip will continue to remain 
disabled & Bluetooth® LED will continue to stay OFF until the device is power cycled
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Factory Reset4.3.4

Reset Forgotten Password4.3.5

The factory default button on Tune page restores the settings to factory default values.  Please note 
Factory Reset will reset Modbus Slave ID to 1 and Tune mode password to 1234. Factory reset does not 
change user assigned Tag number.

To reset a forgotten password, please contact Forney Service Department to request the unit specific 
password.  Please provide last five digits of the unit serial number and its six-character Tag name when 
requesting reset password. Forney will generate a device specific password which can then be used to 
enter tune mode and reset the standard password to a desired password.  A new device Specific Master 
Password may be required if locked out again.

The Spectrum Analysis (FFT) provides insight into the signal from each sensor (UV or IR).  It helps identify 
frequency windows and respective amplitude specific to the target flame and used as a guide to change 
parameters on the Tune screen (Figure 17).  Signal amplitude values are at frequency bin intervals of 2 
Hz. For example, amplitude at 60 Hz frequency is displayed at frequency bin 30 on the spectrum screen. 
To view the Spectrum Windows simply:

• Click on Spectrum from the pop-up menu.
• Use the check boxes in the top right corner to select IR or UV.
• Use the drop-down menu to select the best scale interval 250, 500, 750, and 1100 for viewing the   
   spectrum.

SPECTRUM4.4

Save Tuning4.3.3
Two options exist to save settings in Tune Mode, “Update Detector” or “Save Locally”.  The “Update 
Detector” sends the desired settings from HD Connect to the HD Flame Detector and saves them on the 
Detector.  A confirmation is issued from the detector to the HD Connect.  HD Connects displays success 
or failure in a subsequent pop-up window.  Alternatively, the existing settings can be saved at a desired 
location on the computer using the “Save Locally” button in Tune window.  Please note that the values on 
the left column(s) of ONLY FR1 and FR2 are saved while the values under Device Settings section are 
NOT saved. Only settings for active profile are saved. Forney recommends user include profile number in 
saved file name for easy identification later. If an application requires use of more than one profile, each 
profile must be activated through profile select inputs prior to saving settings.

Previously saved tunings can be uploaded from the computer by clicking Saved Tuning in the Menu bar. 
This feature allows the user to upload the same settings on multiple HD Flame Detector devices. 



Figure 23 Spectrum Window for UV sensor
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Figure 24 Spectrum Window for IR sensor

TAGS4.5
Click on the Tags to review the information about all available tags and their relevance for the Flame 
Detector.  The Tags window show the register numbers, their descriptions, and associated values for 
various registers of HD Flame Detector.  In case of normal communication with HD Flame Detectors, 
these values are displayed in different windows of HD Connect.  For example, Slave ID (Register # 
40000) is displayed on Monitor, Tune, Spectrum windows. In case of communication issues between HD 
Flame Detector and HD Connect, the values associated with Tags can be useful to troubleshoot issues 
by a Forney Professional.
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Figure 25 “Tag List”  Window in HD Connect

LIVE TRENDS4.6
Live data for Flame Relay 1, Flame Relay 2, and Internal Temperature can be viewed for any connected 
HD Flame Detector.  Hover the mouse over the Live Trends option to view its sub-menu. When any of the 
options (FR1, FR2, or Internal Temperature) is clicked, the Live Trend window opens and starts plotting 
the live data from the Flame Detector (right-top screen in Figure 26).

Save Live Trends: To save a trend, click “Save Trend” button and save file to a desired location on the 
computer (right-bottom screen in Figure 26).

View Previously Recorded Trends: Click on the “Recorded Trends” tab and select “Load Trend” button to 
locate and open a previously saved Live Trend (left-bottom screenshot in Figure 26).
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Figure 26 Live Trends and Options

Click tab

DATA LOGGING4.7
Data logging can be initiated by setting COM port, Modbus Slave ID and From/To time for any specific HD 
Flame Detector.  Any or all registers can be chosen to record current or future data.  The data will then 
be stored at the user specified location and can then be imported into Excel® for further analysis. The 
Configure Data Logging tab shows the various options to start data logging.  The Log History tab shows 
previously saved data files.  

NOTICE: Data logging is not password protected; so data saved by one user can be viewed by 
another user provided they exchange data files.
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Figure 27 Configure Data Logging Tab of Data Logging Screen

Figure 28 Log History Tab of Data Logging Screen
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FAULT STATUS4.8
Clicking on Fault Status opens the Fault Status window as shown in Figure 29.  If the red fault LED on the 
HD Detector is lit, click on the Fault Status window to determine the cause for the fault. The fault type and 
fault counters for each sensor are shown here.  Power cycling the detector resets the fault alarm on the 
detector (red LED is no longer lit), however it does not clear alarms displayed on this screen.  

If any HD is in fault state with red LED on the front display lit, user should:

1. Reset fault by cycling power to the HD Detector, this will clear the detector out of fault state (red LED  
    on front display will turn off),
2. Then use the Fault Status page in HD Connect to determine the reason for the fault.
3. Use ‘Clear Alarms’ button to clear alarm displayed on this screen. Alarm counters will continue to  
    display current value.

NOTICE: The Alarms must be cleared after a fault occurs to accurately determine fault next time.

Figure 29 Fault Status Window
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Table 4 Fault Codes

Value Error Description

0 No Error

1 Unknown HW (Hardware) Fault

2 Unknown SW (Software) Fault

3 HW Fault - EEPROM

4 SW Fault - Factory Values Reset

10 Temp Fault

11 Temp Alarm

12 Temp Above

20 Modbus Error

24 Illegal Slave ID

30 Bluetooth Error

33 Illegal Data Value / Value Not Accepted Outside of Tune Mode

35 Bluetooth pairing failed

36 Bluetooth Connection Error

37 Bluetooth Authentication Error

40 FR1 Sensor Fault

50 FR2 Sensor Fault

60 Watchdog Fault

70 FR1-New Discrepancy Fault

80 FR2-New Discrepancy Fault
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SECTION 5
APPENDIX

CONTACT INFORMATION5.1

COMMON ACRONYMS5.2

For assistance, contact Forney’s Aftermarket Department via any one of the following methods.

Email Phone Fax

spares@forneycorp.com

972-458-6100 or
972-458-6142 or
1-800-356-7740  

(24-hour direct line)

972-458-6600

FFT Fast Fourier Transform

FR Flame Relay

HW Hardware

IR Infrared signals

SW Software

UV Ultraviolet Signals


